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FCC Notice

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance the instructions, may cause harmful interference
to radio communications. However, there is no guarantee interference will not occur
in a particular installation. If this equipment causes harmful interference to radio or
television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

»  Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

»  Consult the dealer or an experienced radio/TV technician for help.
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Chapter 1: Equipment Handling

1. Equipment Handling

VMS 300 hardware is designed to be rugged for portable use, however it is not a sealed unit
and care must be taken to protect the connectors and electronic components.

A

Protect the unit from exposure to water, excessive dust or dirt, and excessive
physical or electrical stress.

A

Ensure VMS 300 power switch is in the Auto position before connecting 120 VAC or
12 VDC power adapter. Power switch should not be in the On position when connect-
ing external power.

A

If you use VMS 300 with 120 VAC power, use ONLY the adapter supplied with VMS 300.
Other models may specify 7-16 VDC output, but they may allow power surges that will
damage the hardware.
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Chapter 2: VMS 300 Parts Inventory

2. VMS 300 Parts Inventory

[tem Quantity Notes
VMS 300 GPS hardware 1 Required, included
VMS 300 GPS antenna 1 Required, included
LanC (2.5mm stereo) cable 1 Required, included
Microphone/Headphone L
(3.5mm stereo) cable 1 Required, indluded
Computer serial (9-pin) L
cable 1 Required, included
Cigarette lighter adapter 1 Included
120 VAC adapter 1 Included
Battery 1 Included, Ni-MH 6V, 4-6 hr.
Battery charger 1 Included
Required if using voice
Microphone headset 1 recognition, included with
complete system bundle
Video capture device, Required for video capture or
internal PC, external USB, As ordered onscreen review, included with
or PCMCIA complete system bundle
- Optional accessory,
Digital compass As ordered order separately
Feature trigger As ordered Included
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Parts Diagram

Optional items not shown. Some parts may differ slightly in appearance.

Battery 9 Pin Serial Cable

Cigarette Lighter 120 VAC GPS Antenna

Adapter Adapter

Battery Charger Lan C Cable Microphone/
Headphone Cable
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3. Principle of Operation

The Global Positioning System (GPS) is a satellite network that continuously transmits radio
signals used by receivers on earth to calculate location information. VMS 300 converts GPS
data into audio signals, which are sent to a video camera through its microphone input
connector. These audio signals are recorded on the left channel of the audio track. If the
video camera records in stereo, the right channel is available for voice recording.

Recording Video

VMS 300 enters recording mode when it obtains a navigational fix, or transmission of location
data from the GPS. In recording mode, GPS data are transmitted once per second to the
video camera by VMS 300 as video is recorded. Each GPS location is associated with a time
code on the video, and that section of video can be referenced by its indexed GPS data.

Indexing Video

MediaMapper is the desktop mapping software that controls indexing and review of the video.
VMS 300 translates GPS data from the video to MediaMapper as the video is replayed.
MediaMapper creates a database that cross-references the GPS locations and video time
codes. The database creation procedure is called indexing. MediaMapper also displays a map
showing the GPS-referenced locations. Each point on the map represents a location where
video was recorded with GPS data.

Reviewing Media Maps

When indexing is completed, VMS 300 provides random access to the original video when
you select locations on the map. With the video camera and VMS 300 connected to the
computer, you can review the video by selecting a GPS data point or feature on the map.
MediaMapper controls the video camera to play the section that was recorded at the selected
location.
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Chapter 4: |dentification of Controls and Connectors

4. |dentification of Controls and Connectors

Hardware Unit

Front

GPS/Diff/Aux 1 Connector

Serial connector used to input RTCM 104 differential GPS correction data or external NMEA
0183 GPS data. In addition to external GPS, differential or DGPS receivers, this connector is
used for data transfer with laser rangefinders. If accessory devices other than external GPS

receivers are used, set the option for this connector in the MediaMapper Options dialog box.

Data Input Specifications:

Baud rate 4800 or 9600
Bits 8

Parity none

Stop Bits 1

Front
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GPS Antenna Connector VP

Connects to the included GPS antenna cable if using VMS 300 with internal GPS. This
connector is not present on VMS 300 without internal GPS.

Mic In Connector

Accepts a mono microphone for recording voice information on the right audio track of the
videotape (if camera is capable of stereo recording). If using a headset (microphone/head-
phone unit) for recording, audio status indicators can be heard through the headphones, and
voice recording is enabled for the microphone.

Aux 2 Connector

This RJ45 connector is used with the Red Hen Systems feature trigger or digital compass.

Video Camera Connections L =1
10 ¢
Microphone/Headphone Connector ]O

Connects to video camera microphone input in recording mode, and connects to video
camera headphone output in review mode. Uses the included 3.5mm stereo cable.

NOTE: the signal level for this connector is set to microphone levels (~10mV). If line levels
(~1V) are needed for a nonstandard recording or playback device, this option may be
configured using MediaMapper. See Chapter 5: Setup for Recording Mode.

See Setting Preferences in the MediaMapper Software User Manual for information about
adjusting VMS 300 hardware settings.

For line level connections, insert the 3.5mm stereo end of the appropriate cable (not in-
cluded) at this connector, and insert the RCA connectors on the opposite end of the cable at
the Line In/Out jacks on the VCR or other recording and playback device.

LanC Connector @

Connects VMS 300 to LanC connector of video camera or other compatible playback device.
This connection allows VMS 300 to control the video camera or VCR playback functions.
Uses the included 2.5mm stereo cable.
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Back

Power Switch

Switch On to keep VMS 300 on continuously. If the video camera supplies microphone power
(usually labeled as “Mic Pwr” near the video camera microphone input), you may leave the
Power Switch in the Auto position while in recording mode. This automatically turns VMS 300
on when the video camera is on.

Power Input e

A 7-16 V adapter jack. Accepts the included AC power adapter or cigarette lighter adapter.
Depending on options, the system can draw up to 300mA current.

IMPORTANT: Use only the supplied 120 VAC adapter. Insure the power switch is in the Auto
position before connecting external power. The power switch should not be in the On position
when connecting a power adapter.

Computer Serial Connector

Connects VMS 300 to a computer using the included 9-pin serial cable. The recorded GPS
data is sent to the computer through this connection.

Data output specifications:

Baud rate 9600

Bits 8

Parity none

Stop Bits 1
Speaker

Outputs the status tones and
clicks the system emits. See
Indicators for a list of what

the system sounds mean.
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Indicators

Lights

Nav Light and Data Light

There are several different ways the lights flash to indicate status. When powering up, the
lights flash in the following order:

1. All flash initially
2. Data light stays on momentarily after power up
3. Nav light flashes after power up until GPS fix is obtained.

Other signals during operation:

See NOTE after Audio section.

Power Light

Indicates the unit has power.

If lights do this: It means this:
Nav light flashes fast no GPS fix obtained
Nav light on continuously GPS fix obtained
Nav light on two seconds, off half-second differential fix obtained
Data light blinking sending GPS data to camera or computer
All lights on continuously battery low
Power light blinks once per second tGoltj)Smuch data being received by external
vaﬁ; c;)roNWae\:;igl;tpon, but no power light self test failure

10
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Audio

While recording, the speaker outputs several audio status indicators.

If you hear this: It means this:
three beeps power has been turned on
two beeps, low to high GPS fix has been acquired
two beeps, high to low GPS fix has been lost
one high beep differential signal has been acquired
one low beep differential signal has been lost

Additionally, you can use MediaMapper to set whether the hardware should emit clicks when
data are transferred. The settings are selected in the Options dialog box, VMS Hardware tab.

NOTE:

If your camera supplies microphone power: operation of the Data light and the “Click if
navigating” options normally depend on detection of microphone power from the video
camera. This feature alerts you if the microphone cable is disconnected while recording. If
your video camera supplies microphone power, it is probably labeled “Mic Pwr” by the
microphone input connector. Microphone power is not an actual power supply for VMS 300.

If your camera does not supply microphone power: you can use MediaMapper to set the
VMS 300 hardware lights and sounds. To keep lights and sounds activated when no micro-
phone power is present, clear the “Equipped with microphone power” check box in the
Camera Setup dialog (Options dialog box, VMS Hardware tab). See Setting Preferences in
the MediaMapper Reference Manual for more information.

11
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Chapter 5: Setup for Recording Mode

5. Setup for Recording Video with VMS 300

Hardware Configuration Options

IMPORTANT: To determine the correct system configuration for your application, please read
through this section before continuing on to the setup instructions.

VMS 300 hardware is shipped ready for normal use without the addition of external accesso-
ries or a nonstandard recording and playback device. However, there are some setup options
you should know about if you use a recording and playback device other than a standard
video camera, or if you will use accessory equipment during recording.

Optional VMS 300 settings (i.e., baud rate, or specifying a line level recording device) are
selected in the MediaMapper Options dialog box. See Setting Preferences in the
MediaMapper Software Manual for more information. To set these options, the VMS Hard-
ware must be connected to the computer.

Options

VMS 300 without internal GPS, accepts data from another GPS receiver and sends to video
camera

External GPS or DGPS receiver, VMS 300 will bypass the internal GPS receiver if you use
an external GPS receiver

External differential receiver with RTCM output, for real time differential correction when
using VMS 300

Digital compass accessory, for recording camera direction

Feature trigger accessory, marks locations of interest in the field

Laser rangefinder that outputs NMEA data strings

Nonstandard recording or playback device requiring line power levels

Explanations of these optional configurations are included on the following pages. After the
setup instructions in this chapter, you can find more detailed information about using the Red
Hen Systems digital compass and information on using external GPS receivers.

13
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VMS 300 without Internal GPS

This is a hardware version that must be special ordered. It requires an external GPS or
DGPS receiver connected at the GPS/Diff/Aux1 port.

VMS 300 with Internal GPS

The current model contains a 12-channel Thales Navigation B12 receiver. The B12 supports
differential remote operation and is capable of tracking Satellite Based Augmentation Syatem
(SBAS) satellites. It will recieve signals from WAAS, EGNOS, and MSAS. The VMS 300
uses the signal from the internal GPS unless you connect an external GPS or DGPS receiver
to the GPS/Diff/Aux1 port. VMS 300 bypasses the internal GPS when there is signal input
from a compatible, GPS or DGPS receiver (see External GPS or DGPS Receivers below).
This receiver outputs data in NMEA when it has a 2D or 3D navigational fix.

External GPS or DGPS Receivers

Whether you have VMS 300 with or without internal GPS, you can connect an external GPS
or DGPS receiver that outputs NMEA 0183 (version 2.0 or later) data to the VMS 300
hardware unit at the GPS/Diff/Aux1 port. VMS 300 detects the signal from the first navigating
GPS receiver, so if no antenna is connected to the internal GPS receiver, then the signal from
the navigating external receiver will be recorded.

The NMEA strings required by VMS 300 are GGA and RMC. Chapter 7 contains more
explanation about using external GPS, differential, or DGPS receivers.

External Differential Receivers

You can use a differential receiver with VMS 300 for real time differential correction when
navigating in the field, or for collecting differentially-corrected data. Set the differential
receiver to output at 4800 baud.

14
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Digital Compass and Feature Trigger
These accessories from Red Hen Systems connect at the Aux2 port.

Compass: A digital compass can be connected to VMS 300 to provide information on the
direction the camera is pointing while recording. The feature trigger on the compass can be
used to mark special sites on the video for automatic feature creation on the map. While
recording, compass data is sent to the video with the GPS location data. When you review
the resulting map, a special cursor shows the camera direction.

Feature Trigger: The feature trigger records a signal on the video, which tells MediaMapper
to create a map feature at the current GPS location when the Recorded Features tool is on.

Laser Rangefinder

VMS 300 works with laser rangefinders that output a NMEA 0183 (version 2.0 or higher)
formatted data string. The rangefinder records the user’s horizontal distance and Azimuth
from an object. This information is read by MediaMapper during the indexing process. Laser
rangefinders must be used with a digital compass, because MediaMapper requires both
distance and azimuth information to correctly map the ranged points. The resulting map
displays each targeted object at its true location (within applicable accuracy limits for the
equipment used), and the camera position is viewed as an “anchor” position.

Before recording, set up VMS 300 to accept laser rangefinder data. Connect the VMS
Hardware to the computer, then choose the rangefinder output baud rate on the VMS
Hardware tab of the MediaMapper Options dialog box (see Setting Preferences in the
MediaMapper Reference Manual for more information).

Set up the rangefinder to output NMEA data in accordance with manufacturer’s instructions.

General Tips for Using Rangefinders

Compatible rangefinders include certain models manufactured by Measurement Devices Ltd.
(MDL), Laser Technology, Inc. (LTl), Laser Atlanta, and Leica. Check the Red Hen Systems
web site for a current list of models or find out from the rangefinder manufacturer what kind
of data output is available.

For highest accuracy of laser-ranged points, you should set up VMS 300 so that the GPS
antenna is situated near the rangefinder. This way, you will be properly collecting data on the
range and direction of the object from the GPS antenna. |If the antenna is situated next to the
rangefinder, the data will be within the limits of differentially-corrected GPS accuracy.

15



VMS 300 Hardware User’s Guide

Avoid using a laser rangefinder with magnetic compass near sources of magnetic fields.
Magnetic fields interfere with magnetic compass operation. The VMS 300 GPS antenna
contains a magnet for mounting, which can be removed.

Before ranging objects, insure that the video camera is recording, and that a GPS fix has
been obtained by the receiver (indicated by the steady Nav light and the blinking Data light).

For questions about rangefinder requirements not covered in VMS 300 documentation, send
e-mail to Red Hen Systems at info@redhensystems.com.

Camera Setup

Standard Video Camera

The standard recording and playback device referred to in VMS 300 documentation is a video
camera (either analog or digital) that has a LanC connector, a microphone input connector,
and a headphone output connector. The standard video camera should also supply micro-
phone power, for optimal use of the lights and sounds of the VMS 300 unit. These require-
ments are met by many Sonye video camera models; for this reason, Red Hen Systems
recommends Sony video cameras.

A list of models compatible with VMS 300 is available at www.mediamapper.com.

The LanC connector is required only for indexing and video review, therefore recording can be
accomplished with a video camera that has only a microphone input.

The microphone or line input is required for recording GPS data on the video.

The headphone output is required for sending the GPS data from the video to the computer
during indexing and review.

16
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Line Level Option

You can use a nonstandard recording or playback device, such as a VCR, for recording or
playback. Line In/Out connections may be substituted for the microphone input and headphone
output connections. If using line level connections with devices other than Sony, the line level
preference must be set for the VMS 300 hardware. Set this in the MediaMapper Options dialog
box, VMS Hardware tab. See Setting Preferences in the MediaMapper Reference Manual for
more information. If using line levels with a Sony device, this will be detected automatically by
the VMS 300 hardware without adjusting settings.

Time Codes

NOTE: RC time code is the standard for digital video (DV) cameras, so you do not need to
set a DV camera to record with RC time code.

Some analog video cameras can be set for two types of time coding: normal, or RC time code.
In normal mode, the time counter is related to the camera winding mechanism, and is not
associated with any real “code” on the tape. RC time code is actually recorded, so it can be
used to accurately locate any place on the video. RC time code is recommended.

MediaMapper uses either RC time code or the normal tape counter to control review functions.
RC time code provides certain advantages, including the ability to accurately search a tape from
any starting point (that is, you do not have to rewind to the beginning and set the timer to zero
before each use of the tape).

If you have an analog video camera and you do not use RC time code, review functions rely on
the normal tape counter. The video camera tape counter must be set to zero with the tape fully
rewound at the beginning of each session. In this mode, video review at selected features may
be variable by a second or two.

IMPORTANT: When using a digital or RC time code camera, do not leave blank spots
between recorded sections of videotape. The time code will reset to zero at the beginning of
each section, and MediaMapper will treat these segments as separate tapes.

If you accidentally record a tape with blanks in it, you can dub the entire tape onto another
tape to enter RC time code over the whole tape. Alternatively, you can treat each section like
a separate tape and index each section individually. When indexing starts, use the Device
Controls tools to locate the 00:00:00 point at the beginning of a section, then continue
indexing normally until the end of the section. If you do this, you will need to locate the
correct tape section before accessing video for map features in that section. A solution to
this potential problem is to format videotapes before use. To do this, simply record over the
entire tape once (this can be done with the lens cap on, just start recording and leave the
camera to finish). The purpose of this is to enter timecode over the whole tape.

17
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Setup for Digital Camera, or RC Time Code-Enabled Analog Camera

The MediaMapper Options dialog box contains a checkbox to indicate that you have a digital
camera (or an analog camera with RC time code). To do this, perform the following with the
camera and VMS 300 hardware connected to the computer.

Select Edit>Options, then select the Hardware tab.

Click Camera Setup, then check the box for RC Time Code or Digital.

Video Camera Volume

IMPORTANT: If the camera’s volume setting is near the maximum or minimum setting, GPS
data will not be processed properly by VMS 300. Set the video camera volume near the
middle of the range for best results. Some adjustment may be necessary.

The most common problems encountered during indexing and review involve an incorrect
camera volume setting. If it appears that GPS data is not being detected by MediaMapper
while the tape is playing, check that the camera volume is set near mid-range. You can
disconnect the cable from the camera’s headphone output to hear the sound through the
camera. The VMS 300 GPS data sounds similar to a computer modem. If you can hear this
cyclic “beeping with static” sound, then there is GPS data on the tape.

18
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Setting up VMS 300 with Video Camera for Recording

GPS Antenna

Microphone
Input

GPS Antenna
Connector

Microphone/
Headphone

Shown is the simplest configuration for recording video with VMS 300.

Optional devices may be added, for example, an external GPS receiver connected at the GPS/
Diff/Aux1 port, a feature trigger connected at the Aux2 port, or headset microphone connected at
the Mic In connector. See numbered items marked as Optional in the setup instructions.

19
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Video Setup and Recording Instructions

1.

Thoroughly review the information in the preceding sections on hardware options.

« If using accessory or nonstandard devices, there may be settings required in the
MediaMapper Options dialog box, VMS Hardware tab.

» If using the Red Hen Systems compass, see Using the Digital Compass in this chapter
for compass calibration and setup, then proceed with these instructions.

Connect the GPS antenna supplied with VMS 300 if you are using the internal GPS
receiver (either alone or in conjunction with a differential receiver).

-0Or-

(Optional) Connect your external GPS or DGPS receiver to the GPS/Diff/Aux1 connector.
VMS 300 will accept the signal from the navigating receiver.

(Optional) Connect a differential receiver to the GPS/Diff/Aux1 connector if desired.

Connect the 3.5mm stereo cable between the VMS 300 Microphone/Headphone connector
and the video camera’s Microphone Input connector.

IMPORTANT: Insure the 3.5 mm stereo cable is connected to the Microphone Input on your
video camera. Do not connect it to the video camera Headphone Output during recording.

-0Or-

If using a recording device with Line In/Out connectors, insert the 3.5mm stereo end of the
appropriate cable (this should be supplied with the recording device) to the VMS 300 Micro-
phone/Headphone connector, and insert the RCA connectors on the opposite end of the cable

in the Line In/Out jacks on the recording device."
Install a charged battery.
-0Or-

(Optional) For use in a vehicle, connect the 12 VDC power (cigarette lighter) adapter to the 7—
16V power connector. Insure power switch is set to Auto before connecting.

After power connections are made, the power switch may be in either the On position or the
Auto position. In the Auto position, VMS 300 is powered when the video camera is on, and

1 The system is set up for microphone recording levels by default. If line levels are needed for a
non-standard recording device, set this in the Options dialog box of MediaMapper. See
Chapter 2: Setting Program Preferences in the MediaMapper Reference Manual. For Sony
devices, VMS 300 detects both microphone or line levels, and no special setup is required.

20
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remains off when the video camera is off. (Applies to cameras that supply microphone power. If

10.

1.
12

o > 0D

your camera does not supply microphone power, turn the VMS 300 unit On.)

(Optional) To make voice annotations while recording, connect the microphone headset to the
VMS 300 Mic In connector.

(Optional) To use the feature trigger accessory, connect it to the Aux2 connector.

(Optional) To use a laser rangefinder with VMS 300, connect it to the GPS/Diff/Aux1 connec-
tor. The rangefinder must be set up to output NMEA data according to the manufacturer’s
instructions, and the VMS 300 hardware must be set to accept the rangefinder output. See
the section on Laser Rangefinders for more information.

Check the VMS 300 status indicators to ensure that the receiver has a navigational fix and is
sending GPS data to the camera.

Ensure the video camera volume is set at approximately midrange.

Operate the video camera in accordance with the user’s manual. VMS 300 sends GPS data
to the video as you record.

Test Your Setup

Before recording important data in the field, you should test your setup to verify the GPS data
is being recorded. The most common problems involve connecting the stereo cable incor-
rectly or having the camera volume turned too far up or down.

Follow the setup steps.

Record a minute or two of video outside when the GPS has a fix.
Rewind the video.

Remove the cable from the video camera Microphone In connector.

Play the video. You should hear the modem sound that indicates GPS data is recorded on the
tape.

Rewind the tape to the beginning, and reconnect the cable to the Microphone In connection.

21
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Using VMS 300 for Real Time Navigation

VMS 300 is normally used to provide an efficient and convenient method of GPS and
multimedia data collection in the field. The option to leave the computer behind is a key
feature of VMS 300, but there may be a situation when you want to follow your progress on a
computer screen while navigating to a point or retracing a path.

To use VMS 300 for real time navigation

Set up the video camera and VMS 300 hardware unit for recording (see Chapter 5).

If using a differential or DGPS receiver for real time differential correction, connect it to the
GPS/Diff/Aux1 port. Set the external receiver to output at 4800 baud.

Connect the included 9-pin serial cable between the PC connector on the VMS 300 hardware
unit and the COM port on the computer.

Turn the VMS 300 unit On to send GPS data to the computer continuously.

(If the VMS 300 Power switch is in the Auto position, GPS data will be sent only when the
video camera is on. Set to Auto if performing procedures starting at Step 7 below, for
simultaneous indexing and recording.)

Start MediaMapper or another NMEA data-compatible mapping and navigation program.

You will see the GPS cursor on the screen. It tracks your movements in real time on the map
to within one second (slight delay due to GPS data transmission rate from VMS 300). Use
zoom tools as needed for the best view.

(Optional) To record and index the video simultaneously:

a. Connect 2.5 mm stereo cable between the LanC connector on the video camera and the
LanC connector on the VMS 300 hardware unit.

b. To index video while recording, you must use MediaMapper software. With the program
running for navigation, select File>Add Media and select Index Video Tape Created
Using VMS Hardware.

c. Enter a name for the new GPS index, and select to Index entire tape if starting a new
video recording. If adding to an existing video recording, select continue indexing from
and enter the time code.

d. Click Next to begin the indexing process, then record video. When finished, click the
Stop button on the indexing progress indicator.

22
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Using the Red Hen Systems Compass

CAUTION: Stray magnetic fields can interfere with the operation of the compass. The Red
Hen Systems compass is a magnetic compass, which senses the earth’s magnetic field.
Other magnetic fields close to the compass can cause incorrect readings. The calibration
procedure nullifies the effects of small magnetic fields produced by the camera. Calibration
must be repeated when the compass is used with different equipment, for instance a different
video camera (even if it is the same model), a different video camera battery, or a tripod. A
nearby metal object or structure such as an automobile, metal scaffold, bridge, or building
can affect the local magnetic field and reduce the accuracy of the compass. Calibrate the
compass outdoors, away from such objects.

Compass Measurements

The Red Hen Systems compass works with compatible Sony video cameras and the VMS
300 hardware unit to record the camera’s direction along with the GPS data from VMS 300.
Compass data includes azimuth, pitch, and roll.

MediaMapper software automatically converts the compass magnetic north measurement to
true north, so the compass information for each map feature is displayed correctly when
overlaid on background maps.

Measurement Definition Accuracy
Azimuth angle camera is pointed +/- 5° after camera is still for 2
relative to North seconds
Pitch angle camera is pointed up +/- 1° within a range of
or down relative to level +/- 20° from level
Roll angle camera is tilted +/- 1° within a range of
sideways relative to level +/- 20° from level

23
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Compass Setup and Use

VMS 300 Hardware

There is usually no need for a special setup procedure to prepare the VMS 300 hardware to
work with the compass, however, these requirements apply:

The VMS 300 Aux2 port must be set for 9600 baud. This is the default setting, so you should
not need to change it. To check the baud rate, use MediaMapper as follows:

a. Set up the system in review configuration according to the instructions in Chapter 7.
b. Start MediaMapper, then select Edit>Options and click the VMS Hardware tab.

c. Check the Aux2 port baud rate in the upper left section of the dialog box. Change to 9600
if necessary.

d. Click Ok to apply the setting and close the dialog box. The VMS 300 hardware beeps
twice to confirm the baud rate is set.

e. Disconnect the VMS 300 hardware from the computer.

When using the compass in the field, turn the VMS 300 power off and then on after each time
you disconnect or connect the compass. This allows the hardware to detect the current
configuration and set the correct power level for recording.

Connecting the Compass

Insure the compass locking ring is unlocked, then connect the compass to the video camera
by sliding the connector pad beneath the flanges on the camera hot-shoe. The hot-shoe is the
connector that normally accepts an electronic lighting accessory. Twist the compass locking
ring counter-clockwise until it clicks.

Connect the compass stereo cable between the compass MIC connector and the video
camera microphone connector.

Connect the compass RJ45 cable between either of the compass AUX connectors (choose
the most convenient side) and the Aux2 port on the VMS 300 hardware.

You can power the VMS 300 hardware from the video camera battery when the compass is
used. If you want to do this, do not install a battery or other external power on the VMS 300
hardware. This will affect how quickly the camera battery is drained, however, the camera
battery display will accurately reflect the remaining time when VMS 300 is powered from the
camera.

Connect the VMS 300 GPS antenna to the VMS 300 hardware.

24



Chapter 5: Setup for Recording Mode

6. If using a microphone for recording voice notes in the field, connect the microphone to the
EXTERNAL MIC connector on the compass. The microphone will not work through the Mic
connector on VMS 300 when the compass is used.

NOTE: When using a microphone headset with the compass, you will not hear VMS 300
sounds through the headphones.

7. When you reach the location where you want to record video, perform the compass calibra-
tion procedure (see Calibration), then record video as usual. As you record, note that the red
light on the compass indicates proper operation (see Compass LED Indicator).

Calibration

Perform the calibration often. Refer to the Caution at the beginning of this chapter. As a
general rule, calibrate the compass before each day’s use.

To calibrate the compass:

1. Set up the system for recording with compass data (see Setup). Perform the calibration
outdoors, away from objects that may cause stray magnetic fields.

2. Start with the VMS 300 power switch set to Auto.

3. Push and hold the compass FEATURE button, then turn on the video camera. The VMS 300
hardware should power up and emit a series of three descending tones (beeps) to indicate
the system is in calibration mode. After you hear the tones, release the FEATURE button. The
LED on the compass flashes while the compass is in calibration mode.

4. Begin turning slowly in a circle while simultaneously moving the video camera in the pattern
described and illustrated on the next page.

Complete 2 full circles (clockwise or counterclockwise), taking at least 30 seconds to com-
plete each circle. This step should take at least one minute.

5. Push and release the compass FEATURE button. You will hear two high beeps if the calibra-
tion was successful, or one low beep if the calibration failed. In case of a failure, check the
nearby environment for anything that could cause a strong magnetic field. You may need to
move to another location before you try the calibration again.
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How to Move the Camera During Calibration

Perform these movements simultaneously during Step 4 of the calibration:

«  Turn slowly in a circle. Remain at the center of the circle (do not walk around the perimeter).
Make two revolutions in approximately one minute.

*  Move the camera in an up and down cyclic motion with a range of +/- 20-30°. Complete each
cycle in approximately 5-10 seconds.

«  Tilt the camera slightly from the horizontal in a cyclic motion with a range of +/- 10-20°.
Complete each cycle in approximately 5-10 seconds.

The images below illustrate how to move while calibrating the compass. The combined
motion may seem somewhat complex, however you do not need to be concerned with
perfection. As long as the compass moves through a full range of these motions, you do not
need to reproduce each “cycle” exactly.

SRR

Remain in the center while Tilt the camera slowly
turning around in a circle up and down
: %
Tilt the camera slowly The combined movements do not
from side to side need to be perfect
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Compass LED Indicator

The light (LED) on the compass operates when the camera is turned on. The LED stays on
continuously to indicate that all connections are made properly and that VMS 300 has
obtained a GPS fix. If the LED does not light, check the setup procedures for proper cable
connections, and make sure the GPS antenna is not obstructed from receiving GPS signals.

When the LED is lit, GPS and compass data are being sent to the camera for recording.

The LED blinks in calibration mode.

Using the Feature Trigger

You may use the feature trigger while recording. The feature trigger sends a message that will
cause MediaMapper to automatically create a map feature during the indexing or review step.
The map features will be created when you use MediaMapper’'s Recorded Features tool as
you replay the video.

To use this option, push and release the FEATURE button once as you video a location of
interest. You will hear a single tone from the VMS 300 hardware indicating that a feature has
been recorded. For best results in using MediaMapper to capture still images from the video,
record for several seconds at the location, and push the FEATURE button in the middle of the
video segment.

Using Video Camera Photo Mode with the Compass

If you use the photo button on the video camera to create still images on the videotape, hold
the camera steady in the direction of the image for the entire six seconds as the still image is
recorded. Because compass data is continuously recorded, this insures the correct compass
information will be recorded with the image.

Removing the Compass

1. Turn the locking ring fully counter-clockwise to unlock it.

2. Gently tilt the front of the compass slightly downward while sliding the compass from beneath
the hot-shoe flanges. If you push the compass directly forward, you could have difficulty
removing it.
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More Information on External GPS Receivers

NMEA 0183 Version 2.0 Interface’

VMS 300 is compatible with most external GPS, differential or DGPS receivers through the
GPS/Diff/Aux1 connector. The external receiver must be set to output the following:

Data Type NMEA 0183, version 2.0 or higher

Baud rate 4800 or 9600 for autonomous, 4800 for differential or DGPS
Bits 8

Parity none

Stop Bits 1

You can use an external GPS or DGPS receiver whether or not your VMS 300 unit has an
internal GPS receiver. The system will automatically accept data from the external GPS
receiver if it has a fix.

NOTE: When using VMS 300 with an external GPS that has a data logger or hand-held
computer, the VMS 300 hardware unit is connected directly to the GPS receiver, not to the
data logger. You will have one receiver port connected to the data logger, and another
receiver port used as the data output to the VMS 300 hardware unit's GPS/Diff/Aux1 port.
Your GPS receiver should have a suitable cable for this connection.

RTCM 104 Differential GPS Interface

The internal GPS can be connected to a RTCM 104 differential receiver through the
GPS/Diff/Aux1 port. You can use this type of receiver for real time differential correction and
navigation with VMS 300. Set the differential receiver to output at 4800 baud.

Required NMEA Strings

The NMEA strings required by VMS 300 are GGA and RMC. (See next page for information
on certain Trimble® GPS receivers.) These strings contain the information in the diagrams on
the following pages.

1NMEA 0183, Standard for Interfacing Marine Electronic Navigational Devices, Version 2.0, National
Marine Electronics Association, March 1998. http://www.nmea.org
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Using Trimble® GPS Receivers

Some Trimble GPS units do not output the RMC string normally required by VMS 300. Follow
your manufacturer’s instructions to set up your receiver so that it outputs the ZDA and VTG
strings instead. The ZDA and VTG strings will compensate for the lack of RMC. Units known
to require this adjustment are the GPS Pathfinder® ProXR and ProXRS.

GGA - Global Positioning System Fix Data
Time, position and fix related data for a GPS receiver.

Differential reference station ID, 0000-1023
Age of Differential GPS data®
Geoidal separation, meters’
Altitude re: mean-sea-level (geoid), meters
Horizontal dilution of precision -
3--GGA, hhmmss.ss,ll1L1],a, VY82, ., XX, M, XM X e th< CR><LF>
L— Number of satellites in use, 00-12,
may be different from the number in view
GPS Quality indicator'
Longitude - E/W
Latitude - N/S
UTC of position
Notes:
1) GPS Quality Indicator: 0 = Fix not available or invalid
1 = GPS SPS Mode, fix valid
2 = Differential GPS, SPS Mode, fix valid
3=GPS PPS Mode, fix valid
4 = Real Time Kinematic. System used in RTK mode with fixed integers
5 = Float RTK. Satellite system used in RTK mode, floating integers
6 = Estimated (dead reckoning) Mode
7= Manual Input Mode
8 = Simulator Mode
The GPS Quality Indicator field shall not be a null field.
2) Time in seconds since last SC104 Type 1 or 9 update, nul field when DGPS is not used300
3) Geoidal Separation: the difference between the WGS-84 earth ellipsoid surface and mean-sea-level
(geoid) surface, "-" = mean-sea-level surface below WGS-84 ellipsoid surface.

Source: NMEA 0183 - Standard For Interfacing Marine Electronic Devices, Version 3.0, July 1,
2000.
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RMC - Recommended Minimum Specific GNSS Data

Time, date, position, course and speed data provided by a GNSS navigation receiver. This sentence is
transmitted at intervals not exceeding 2-seconds and is always accompanied by RMB when a destination
waypoint is active. RMC and RMB are the recommended minimum data to be provided by a GNSS
receiver. All data fields must be provided, null fields used only when data is temporarily unavailable.

$--RMC,hhmmss.ss,A,l1L11,a, LYY8, XXX, 0000000, X, X, 3,8 " IS UK~ Lr =~
L—Mode Indicator™
Magnetic variation, degrees E/W'
Date: ddmmyy -
Course Over Ground, degrees True
Speed over ground, knots
Longitude, E'W

3Lzltitut:lt:, N/S
Status A = Data valid
= V = Navigation receiver warning

— UTC of position fix

Notes:
1) Easterly variation (E) subtracts from True course
Westerly variation (W) adds to True course
2) Positioning system Mode Indicator: A = Autonomous mode
D = Differential mode
E = Estimated (dead reckoning) mode
M = Manual input mode
S = Simulator mode
N = Data not valid
3) The positioning system Mode Indicator field supplements the positioning system Status field, the Status
field shall be set to V = Invalid for all values of Indicator mode except for A= Autonomous and D =
Differential. The positioning system Mode Indicator and Status fields shall not be null fields.

Source: NMEA 0183 - Standard For Interfacing Marine Electronic Devices, Version 3.0, July 1,
2000.
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6. Setup for Video Processing and Map Review

VMS300 sends GPS information and video time code information to a computer, from a
video camera that has a headphone or audio output connector and a LanC connector.

In review mode, VMS 300 enables computer control of the video camera. To control the video
camera with MediaMapper software, the LanC connection is necessary. Also in review mode,
VMS 300 sends GPS data from the recorded video to the computer. The data is sent to the
computer through the computer serial cable.

IMPORTANT: Check your video camera’s audio playback settings before indexing or map
review. If the camera’s volume is set near the maximum or minimum, GPS data will not be
processed properly by VMS 300. Set camera volume near the middle of the range for best
results. Ensure your stereo video camera is set to play both audio tracks. If the left channel is
turned off, GPS data will not be detected.
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Setting up VMS 300 with Video Camera and Computer

COM Port

Microphone/Headphone

Both front and back views of a single VMS300 hardware unit are shown in this setup diagram.
You may also have a video capture card connection between the camera and computer, and
you may have your computer sound card connected to the camera as well. These options
depend on whether you want to capture video and view real time video on screen, or capture
sound files. Follow manufacturer’s instructions for your device.
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Setup Instructions

1.

Connect the 3.5mm stereo cable from the VMS 300 Microphone/Headphone connector to the
headphone output connector on the video camera. This is different from the recording
setup. Do not connect it to the Microphone Input on your video camera during indexing or
review.

-0Or-

If using a VCR or camera with Line In/Out connectors, insert the 3.5mm stereo end of the
appropriate cable (not included) to the VMS 300 Microphone/Headphone connector, and
insert the RCA connectors on the opposite end of the cable at the Line In/Out jacks on the
VCR or camera.

Connect the 2.5mm stereo cable between the VMS 300 LanC connector and the video
camera LanC connector.

Connect VMS 300 to the computer using the 9-pin serial cable between the VMS 300
Computer Serial connector and a computer serial port (an available COM port).

(Optional) To capture video or review real time video on screen in MediaMapper, connect your
video capture device to the camera using the appropriate cable. This may be an IEEE1394
(FireWire®) cable, a USB cable or S-video cable depending on your capture device.

(Optional) To capture voice annotations with video using a device other than Firewire, connect
a suitable audio cable from the right-channel line out (normally the red audio jack) on the
camera or other playback device to the audio input on the PC sound card. The cable for this
is normally supplied with the video camera.

NOTE: If the audio cable is inadvertently connected to the left channel, you will hear the
“modem” sound of the VMS 300 GPS data through the PC speaker. To correct this, switch
the cable connection to the other audio channel on the playback device.

Connect VMS 300 to a power source (battery or the supplied 120 VAC adapter).

IMPORTANT: Use only the supplied 120 VAC adapter. Insure the power switch is in the Auto
position before connecting external power. The power switch should not be in the On position
when connecting a power adapter.

Perform indexing or review functions according to the MediaMapper User’s Guide, including
adding GPS indexes, using tools, layer management, feature creation and inspection, video
capture, and map exports. See the Multimedia Mapping Tutorial for examples and more
information.
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7. Troubleshooting

General

Most Common Fixes

*  Make sure the power is on and the power source is connected.
» If you are using a battery, insure it is charged.

*  Check cable connections. In particular, ensure the 3.5 mm stereo cable is connected to the
camera’s microphone input during recording, or connected to the camera’s headphone output
during indexing or review.

*  Check the camera’s volume setting. If the setting is too high or too low, the data will not be
recorded or processed correctly by VMS 300. Set the camera’s volume at approximately
midrange.

* If MediaMapper cannot find the VMS 300 hardware connected, ensure the COM port on the
computer is not being “blocked” by another application.

Specific Problems & Solutions

No GPS data detected during review

» If no GPS information is sent to the computer during review, the cursor will not move as the
video plays, and the Data light will not flash.

*  The video camera’s volume control may be improperly adjusted. If the volume is set too high
or too low, GPS data may not be recognized. To fix this problem, adjust the video camera
volume all the way down, then increase slowly. Continue to increase the volume until the
VMS 300 data light begins to flash. This signals that GPS data are now being received. If the
volume is turned up too high, you may hear clicks coming from the VMS 300 speaker.

»  Check the video camera sound settings to ensure the right channel has not been turned off.
Enable stereo sound.

» If connections were incorrect for recording, or if the GPS signal was obstructed, GPS data
may be missing from the video. To test this, play the video without the stereo cable con-
nected to the video camera headphone output. You should hear an electronic beeping and
static sound, like you would hear from a computer modem. If the sound is not on the video,
there is no recorded GPS data. Check your recording connections when you record video,
and make sure that you check the indicator lights and sounds.

»  The camera volume must be adjusted near midrange for proper GPS data transfer.
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No sounds come from VMS 300 speaker

Check MediaMapper Reference Manual for optional sound configurations — all sound may be
turned off.

Nav light does not stop blinking in recording mode

The internal GPS is unable to get a position fix. The Nav light stays on when a GPS fix is
obtained. The GPS may take a long time to obtain a navigational fix on first use or after being
transported a long distance. This time can be an hour or more on Motorola models.

Make sure the VMS 300 hardware has the GPS antenna connected.
Check condition of the antenna cable.
Make sure you are in an open area where satellite signals are not blocked.

Allow the GPS unit to run for a long period of time. After the unit has stored its almanac of
satellite information, it will obtain a fix quickly on subsequent use.

Data light does not come on

GPS data are not being sent to the video camera in recording mode, or to the computer in
review mode. GPS data is not sent to the video camera during recording if the VMS 300 unit
has not determined its position. If Nav light is blinking, the GPS is still locating satellite data.
During review, GPS data is not sent to the computer if the camera volume is not set correctly
(see “No GPS detected during review” above).

Make sure the system is setup properly for recording or review mode.
Check condition of antenna cable if recording.
Make sure you are in an open area where satellite signals are not blocked.

GPS may take longer to obtain a navigational fix on first use. See the section on Cold
Starting GPS.

Microphone power may not be available from the video camera. If your camera does not
supply microphone power, open the Camera Setup dialog from the VMS Hardware tab of the
Options dialog box in MediaMapper. Clear the check box for “Equipped with microphone
power.” This will reset the hardware to operate independently of microphone power.
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No lights come on when unit is turned on

The hardware may have failed its self-test. Check power connection or charge battery and
turn on again. If no lights come on when power is supplied, the unit must be repaired.

All lights stay on continuously

The battery may need recharging. Charge the battery, or use an alternate power source.

Power light flashes when external devices are used with VMS 300

The power light flashes when a data buffer overflow occurs. This is caused by too much data
being received from an external device such as a GPS receiver or a digital compass.

Insure the GPS receiver is sending only the required NMEA strings.

Insure that external devices are sending data at the manufacturer’s recommended rate.

Can’t watch the video on the computer screen in MediaMapper

Make sure your video capture device is connected between the video camera and computer.

Enable the multimedia preview window in MediaMapper IEI if you want to review live video.

While performing video capture with DV, video preview is not available. Review the video on
the camera to select the capture starting and ending times.

MediaMapper can’t find connected VMS hardware

The COM port has been previously assigned to another application.

Some programs, such as PDA linking applications, must be closed before you can access teh
COM port.

In MediaMapper, select Device>VMS Hardware>Setup Manual Connection and choose an
available COM port. Then select Device>VMS Hardware>Retry Auto Connection.

VMS 300 is losing the GPS signal frequently when used near a radio transmit-
ter

Some users have reported this issue when using VMS 300 in helicopters or near strong radio
transmitters or active radar.

Use an RF choke on the stereo cable between VMS 300 and the video camera microphone in
connector.
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Support

If any problem persists after following the available troubleshooting instructions, please send
email to Red Hen Systems, Inc. (please allow at least 24 hours Monday through Friday for a

reply): support@redhensystems.com

Visit the MediaMapper web site for product information, documentation, and current
software updates at: www.mediamapper.com. Check the online user forums for more
troubleshooting information and tips.

If you need further assistance, please call 970-493-3952 from 8am to 5pm (Mountain
Standard Time) Monday through Friday.
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VMS 300 Warranty

1.1 Limited Warranty. Subject to Section 1.3 (“Limitation”), RED HEN SYSTEMS, INC.
warrants to USER that, during the period commencing on USER’s purchase of the VMS 300
Video Mapping System™ (“Product”) and terminating one (1) year thereafter, the hardware
portion of the Product will perform substantially in accordance with the appropriate Documen-
tation provided with the Product at the time of purchase. In the event of a failure of the
Product to comply with the foregoing warranty during the applicable warranty period (a
“Defect”), RED HEN SYSTEMS, INC. shall, at its option, repair or replace the Product or
refund the fees paid by USER (following USER’s return of the Product), or provide a
workaround for the Defect. The foregoing sets forth USER’s sole and exclusive remedies for a
breach of the above limited warranties.

1.2 Return Procedures. Product shall be non-returnable except as provided in Section 1.1
(“Limited Warranty”). USER shall return the Product to RED HEN SYSTEMS, INC.,
INC.,1635 Blue Spruce. #101, Fort Collins, Colorado 80524 USA, freight prepaid, along with
a written statement describing the Defect, proof of purchase and the license. RED HEN
SYSTEMS, INC. shall only be obligated under its warranty for Product with Defects which are
reproducible by RED HEN SYSTEMS, INC. in the execution environment. RED HEN SYS-
TEMS, INC. will be responsible for all return shipping costs of repaired or replacement units
to USER. Replacement Products will be warranted for the remaining warranty period of the
original Product.

1.3 Limitation. The warranties set forth above shall not apply to (i) any third party software
or hardware, whether or not such third party software or hardware is provided by RED HEN
SYSTEMS, INC., except that RED HEN SYSTEMS, INC. will, at its option, repair or replace
the internal GPS card for a one (1) year period following USER’s purchase of the Product; (ii)
any Product which has been modified, repaired or altered, except by RED HEN SYSTEMS,
INC.; or (iii) any Product which has not been maintained in accordance with any handling or
operating instructions supplied by RED HEN SYSTEMS, INC. or has been subjected to
unusual physical or electrical stress, misuses, negligence, accidents, abuse, neglect, vandal-
ism or acts of nature.

1.4 Disclaimer of Warranties. Except as set forth above, RED HEN SYSTEMS, INC. makes
no other warranties, express, implied or statutory, regarding products. All implied warranties
as to satisfactory quality, performance, merchantability, fithess for particular purpose or
noninfringement are expressly disclaimed. Some jurisdictions do not allow the exclusion of
implied warranties or limitations on how long an implied warranty may last, so such limita-
tions or exclusions may not apply to USER.
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1.5. Limitation of Liability. In no event will RED HEN SYSTEMS, INC. be liable to USER for
any special, incidental, consequential or exemplary damages of any kind, including but not
limited to any lost profits and lost savings, however caused, whether for breach or repudia-
tion of contract, tort, breach of warranty, negligence, or otherwise, whether or not RED HEN
SYSTEMS, INC. was advised of the possibility of such loss or damages. Notwithstanding any
other provisions of this agreement, RED HEN SYSTEMS, INC.’s total liability to USER arising
from or in relation to this agreement or the product shall be limited to the total payments to
RED HEN SYSTEMS, INC. for the product. In no event will RED HEN SYSTEMS, INC. be
liable for the cost of procurement of substitute goods. The foregoing limitations shall not
apply to damages arising from death or personal injury to persons or tangible property in any
jurisdiction where such limitation is prohibited by applicable law. Some jurisdictions do not
allow the exclusion or limitation of incidental or consequential damages, so such exclusions
may not apply to USER.
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